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Informations importantes destinées à l’utilisateur
En raison de la diversité des utilisations des produits décrits dans le présent manuel, les personnes qui en sont 
responsables doivent s'assurer que toutes les mesures ont été prises pour que l'application et l'utilisation des 
produits soient conformes aux exigences de performance et de sécurité, ainsi qu'aux lois, règlements, codes et 
normes en vigueur.

Les illustrations, schémas et exemples de programmes contenus dans ce manuel sont présentés à titre indicatif 
seulement. En raison du nombre important de variables et d'impératifs associés à chaque installation, la société 
Allen-Bradley ne saurait être tenue pour responsable ni être redevable (y compris en matière de propriété 
intellectuelle) des suites d'utilisation réelle basée sur les exemples et schémas présentés dans ce manuel.

La publication SGI-1.1, Safety Guidelines for the Application, Installation and Maintenance of Solid State Control 
(disponible auprès de votre agence commerciale Allen-Bradley) décrit certaines différences importantes entre 
les équipements électroniques et les équipements électromécaniques, qui devront être prises en compte lors de 
l�application de ces produits, comme indiqué dans la présente publication.

Toute reproduction partielle ou totale du présent manuel sans l'autorisation écrite de la société Rockwell 
Automation est interdite.

Des remarques sont utilisées tout au long de ce manuel pour attirer votre attention sur les mesures de sécurité 
à prendre en compte :

Les messages « Attention » vous aident à :

• identifier un danger ;
éviter ce danger ;Allen-Bradley, MicroLogix, ControlLogix, SLC, PLC, RSLogix, RSLinx, PanelView, PanelBuilder32 sont des marques commerciales de Rockwell Automation.
DeviceNet est une marque commerciale de l'Open DeviceNet Vendors Association.
Modbus est une marque commerciale de Modicon, Inc.

• Microsoft, Windows et Windows NT sont des marques déposées de Microsoft Corporation aux Etats-Unis et/ou dans d'autres pays.

• en discerner les conséquences.

Allen-Bradley, MicroLogix, ControlLogix, SLC, PLC, RSLogix, RSLinx, PanelView, PanelBuilder32 sont des marques commerciales de Rockwell Automation.
DeviceNet est une marque commerciale de l'Open DeviceNet Vendors Association.
Modbus est une marque commerciale de Modicon, Inc.
Microsoft, Windows et Windows NT sont des marques déposées de Microsoft Corporation aux Etats-Unis et/ou dans d'autres pays.

ATTENTION

!
actions ou situations risquant d�entraîner des blessures pouvant être mortelles, des dégâts 
matériels ou des pertes financières.

IMPORTANT
Informations importantes dans le cadre de l�utilisation du produit.
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Préface

Bienvenue dans PanelBuilder32. Pour vous permettre de vous familiariser avec le logiciel, ce manuel fournit 
l�exemple d�une application. Vous serez guidé à travers les différentes étapes de la création, du chargement et de 
l�exécution d�une application dans un terminal PanelView. 

Sont également fournis des points et la logique à relais qui vous permettront d�exécuter l�application sur les 
réseaux de communication suivants :

• DH+ ou DH-485 ;
• EtherNet/IP ;  
• ControlNet (prioritaire et non prioritaire) ;
• DeviceNet (messagerie d�E/S) ;
• RIO ;
• DF1 ;
• Modbus.

Pour de plus amples informations sur les caractéristiques logicielles de PanelBuilder32, reportez-vous au Guide 
Pratique de PanelBuilder32 et à l�aide en ligne de PanelBuilder32.

PanelBuilder32 fonctionne sous environnement Microsoft Windows. Vous devez bien connaître les opérations 
de base de Windows, telles que l�utilisation des menus, boîtes de dialogue et barres d�outils.
Publication 2711-QS003C-FR-P



2          Préface   
Contenu de ce manuel
• Préface

Présentation du guide et du matériel nécessaire pour créer, charger et exécuter l�application exemple.

• Chapitre 1 - Configuration du système
Description de la configuration des composants du système.

• Chapitre 2 - Présentation de l�application
Description de l�application exemple et de sa fonction.

• Chapitre 3 - Création de l�application
Procédures pas à pas de création de l�application exemple.

• Chapitre 4 - Configuration de la communication
Présentation de la configuration de la communication réseau pour le terminal PanelView et pour 
l�automate.

• Chapitre 5 - Saisie des points de l�application
Utilisation de l�éditeur de points pour entrer les points de l�application.

• Chapitre 6 - Chargement de l'application
Validation et chargement de l�application dans le terminal PanelView.

• Chapitre 7 - Exécution de l�application
Exécution de l�application dans le terminal PanelView.

• Annexe A - Programmes d�application
Liste des programmes logiques à relais qui conviennent à l�application et copie imprimée de chaque 
programme.
Publication 2711-QS003C-FR-P 



Préface        3
Matériel nécessaire
Cette section répertorie le matériel nécessaire pour créer, charger et exécuter l�application sur un réseau RIO, 
DH+, ControlNet, EtherNet/IP, DF1 ou Modbus.

Câbles de chargement

Votre terminal comporte un port RS-232 (DF1), RS-232 (DH485) ou DH-485 pour le transfert des applications. 
Utilisez le câble approprié en vous reportant aux listes ci-dessous.

Port de programmation RS-232 : vous aurez besoin d'un câble pour charger une application sur le port de 
programmation RS-232 d�un terminal PanelView. Utilisez l�un des câbles suivants :

• référence 2706-NC13 (3 m) ;
• référence 2711-NC13 (5 m) ;
• référence 2711-NC14 (10 m).

Pour le terminal PanelView 300 Micro, utilisez les câbles suivants :
• référence 2711-CBL-PM05 (5 m) ; 
• référence 2711-CBL-PM10 (10 m) ;
• référence 1761-CBL-AP00 (0,5 m) ;
• référence 1761-CBL-PM02 (2 m).

Port de programmation DH-485 : pour charger une application dans un terminal DH-485, il vous faut :
• un convertisseur d'interface PC (PIC) référence 1747-PIC et un câble 1747-C10, -C11 ou -C20

ou
• un coupleur de liaison 1761-NET-AIC et un câble 1747-CP3, 1761-CBL-AS03 (3 m) ou 1761-CBL-AS09 

(9,9 m).
Le convertisseur d�interface PC est alimenté par un automate SLC. Si vous chargez une application dans un 
terminal non connecté à un SLC, il vous faudra une alimentation (référence 1747-NP1) ou un coupleur de 
liaison (référence 1747-NET-AIC) sous tension. 
Publication 2711-QS003C-FR-P



4          Préface   
Câbles de communication

Terminaux PanelView DH-485 : pour connecter le port DH-485 d'un terminal PanelView au connecteur 
DH-485 d�un SLC, utilisez le câble DH-485 (références 1747-C10, -C11, -C20).

Terminaux PanelView RS-232 (DF1 ou DH485) : pour connecter le port de communication 
RS-232/DF1 ou DH485 d�un terminal PanelView au port RS-232 d�un automate, utilisez le câble RS-232 
(références 2706-NC13, 2711-NC13 ou NC14). Pour se connecter au port RS-232 8 broches de l'automate 
MicroLogix 1000/1200/1500LSP, utilisez un câble 2711-NC21 ou -NC22. Pour plus d'informations sur les 
configurations réseau, consultez la publication « AIC+ Advanced Interface Converter user manual », référence 
1761-6.4 (en anglais). 

Pour le terminal 300 Micro, utilisez un câble 2711-CBL-HM05, -HM10, -PM05 ou -PM10.

Terminaux RIO : pour connecter le port RIO d'un terminal PanelView au port RIO d�un automate, utilisez 
un câble 1770-CD, équivalent à Belden 9463.

Terminaux PanelView DH+ : pour connecter le port DH+ d'un terminal PanelView au port DH+ d�un 
automate, utilisez un câble 1770-CD, équivalent à Belden 9463.

Terminaux ControlNet : pour connecter un terminal PanelView à un réseau ControlNet, utilisez un câble 
coaxial (référence 1786-CP).

Terminaux EtherNet/IP : pour connecter un terminal PanelView à un réseau EtherNet/IP, utilisez un câble 
à paire torsadée blindé ou non blindé de catégorie 5, équipé de connecteurs RJ45. 

Terminaux DeviceNet : pour connecter un terminal PanelView à un réseau DeviceNet, utilisez un câble 
1485C-P1A50, -P1A150 ou -P1A300. Pour de plus amples informations sur les configurations réseau, consultez 
la publication 1761-6.4 « AIC+ Advanced Interface Converter user manual » (en anglais).

Ordinateur

Configuration minimale requise pour l�exécution de PanelBuilder32 :
• PC Pentium 100 MHz, classe 2 ou supérieure ;
• 30 Mo d'espace disque disponible pour une installation minimale ;
• 270 Mo d'espace disque disponible pour une installation complète ;
• 32 Mo de RAM installée (48 Mo conseillés) ;
• lecteur de CD-ROM ;
• 500 Ko libres de mémoire conventionnelle.
Publication 2711-QS003C-FR-P 



Préface        5
Logiciels
En plus de PanelBuilder32, vous devez charger le logiciel de programmation et de configuration réseau de l�automate : 

SLC ou MicroLogix
Logiciel de programmation APS ; logiciel A.I. pour SLC-500 ; RSLogix 500.

PLC

• Logiciel de programmation série 6200 ; logiciel A.I. pour PLC-5 ; RSLogix 5.

ControlLogix

• RSLogix 5000, version 2.01 ou supérieure ;
• RSNetworks pour DeviceNet ou DeviceNet Manager ;
• RSNetworks pour ControlNet.

Exemples d’application et de logique à relais

Le CD d�installation de PanelBuider32 contient :
• des exemples d�applications (.PBA) pour chacun des terminaux PanelView ;
• la logique à relais nécessaire à l�exécution de l�application pour chacun des protocoles de communication.

Reportez-vous à l�annexe A pour obtenir la liste de ces fichiers.

Les fichiers d�application PanelBuider32 (.pba) se trouvent dans le répertoire Quick Start\PV du CD 
d�installation de PanelBuilder32.

Les fichiers de programmes logiques à relais (.rss,. rsp,. acd) se trouvent dans les répertoires Quick Start\SLC, 
\ML, \CL ou \PLC du CD d�installation de PanelBuilder32.

Tous les autres fichiers de programme, tels que DeviceNet SDN et les fichiers scrutateurs se trouvent dans les 
répertoires Quick Start\DNet ou \CNet du CD d�installation de PanelBuilder32. 

IMPORTANT Vous pouvez installer les applications exemples sur votre disque dur au cours de 
l�installation de PanelBuilder32. Si ces fichiers n�ont pas été installés, vous pouvez 
toujours y accéder depuis le menu d�exécution automatique du CD d�installation.
Publication 2711-QS003C-FR-P
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Chapitre 1

Configuration du système

Les terminaux PanelView existent avec plusieurs options de communication. Ce chapitre décrit brièvement les 
configurations minimales requises pour l�exécution de l�application exemple. Pour des informations plus 
spécifiques, telles que terminaisons de câbles et vitesses de transmission, nous vous conseillons de vous reporter 
au manuel d�utilisation et/ou au manuel de communication fournis avec le terminal. Consultez la section 
correspondant à votre type de terminal.

• DH-485
• RS-232 (DH485)
• RS-232 (DF1)
• RIO
• DH+
• DeviceNet
• ControlNet
• EtherNet/IP
• Modbus 

Directives de sécurité
Pour obtenir des informations sur l'installation et les mesures de sécurité, reportez-vous au manuel d�utilisation 
du terminal PanelView (publication 2711-UM014B-FR-P). 

Ces mesures de sécurité sont également valables si vous exécutez l�application exemple sur votre ordinateur 
avant de procéder à l'installation. Assurez-vous que les équipements sont débranchés avant de faire les 
connexions de communication.
Publication 2711-QS003C-FR-P



8          Configuration du système   
Connexions DH-485
Les terminaux DH-485 communiquent avec des périphériques via le port de communication DH-485 ou le 
connecteur de programmation DH-485. Certains terminaux DH-485 comportent un port RS-232 pour le 
transfert de fichiers et l�impression.

Port série

Station 0
PC

PanelBuilder32

Station 2
Terminal PanelView 1000 DH-485

Connecteur de programmation 
DH-485

Connecteur de 
communication 

DH-485

Convertisseur d’interface PC
(réf. 1747-PIC)

Câbles
(réf. 1747-C10, -C11, -C20)

Station 1
Automate SLC

COM1 ou COM2
Publication 2711-QS003C-FR-P 



Configuration du système        9
Connexions RS-232 (protocole DH-485)
Les terminaux PanelView RS-232 (DH485) comportent un ou deux ports RS-232. Sur ceux munis de deux ports 
RS-232, l�un est le port imprimante et l�autre sert à la connexion à un SLC ou à un ordinateur.

IMPORTANT
Vous devez configurer le port du canal 0 de l�automate SLC 5/03, 5/04, 5/05 ou MicroLogix 
pour la communication DH-485 au moyen du logiciel de programmation APS, AI500 ou 
RSLogix 500.

Câble
(réf. 2711-NC13, 2711-NC14, 

2706-NC13)

Station 2
PanelView 1000 
Terminal RS-232

Station 0
PC

PanelBuilder32

Station 1
Automate SLC 5/03, /04, /05, 

CompactLogix ou MicroLogix 1500LRP

Remarque : utilisez le même câble pour transférer les applications vers le terminal et vers l’automate SLC 
5/03, 5/04, 5/05. Connectez le câble à l'automate après le chargement des applications.

MicroLogix 1000

Vers le canal O

Port série
(COM1 ou COM2)

1761-CBL-HM02

AIC+
1761-NET-AIC

Port DF1
Publication 2711-QS003C-FR-P



10          Configuration du système   
Connexions RS-232 (protocole DF1)
Les terminaux PanelView DF1 comportent un port de communication DF1 (full duplex) et un port RS-232 
pour le transfert de fichiers et l'impression. Le port DF1 du terminal PanelView est un connecteur RS-232 mâle 
à 9 broches.

Automate PLC-5

Liaison série

Câble
(réf. 2711-NC13, 2711-NC14, 

2706-NC13)PanelBuilder32

SLC 5/03, 5/04, 5/05

PanelView 1000

MicroLogix 1000

Port RS-232 pour le transfert de fichiersPort DF1

Câble 2711-NC13, -NC14

Adaptateur
9 à

Port DF1

Port DF1
1761-CBL-HM02

Port DF1

AIC+
1761-NET-AIC
(non requis pour DF1)

ControlLogix 5550, 
CompactLogix ou FlexLogix

25 broches
Publication 2711-QS003C-FR-P 



Configuration du système        11
Connexions RIO
Les terminaux PanelView RIO comportent un adaptateur RIO et un port RS-232 pour le transfert de fichiers et 
l'impression. L'adaptateur RIO permet de connecter le terminal à un réseau RIO 1771. Le terminal PanelView se 
connecte à un scrutateur RIO au moyen d'un câble 1770-CD, équivalent à Belden 9463.

Câble
(réf. 2711-NC13, 2711-NC14, 

2706-NC13)

Station 2
Terminal PanelView 1000 

RS-232

Station 0
PC

PanelBuilder32

Station 1
Automate PLC-5

Port RIO
Câble

 1770-CD
(Belden 9463)

Port RS-232
Port RIO

Bornier de connexion 3 broches

Vers le port RIO

module scrutateur
(réf. 1747-SN)

Station 1
Automate SLC avec

Port RIO

ControlLogix 5550
Module RIO (1756-DHRIO)

Important : le fil avec isolation 
transparente se connecte à la borne 
2 du connecteur RIO 3 broches.

Résistance de terminaison 
82 ou 150 Ohms

2 Transparent
SH Blindage
Bleu 1 Transparent 2

Blindage SH
Bleu 1

Port série
(COM1 ou COM2)

Port RIO
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Connexions DH+
Les terminaux PanelView DH+ comportent un port de communication DH+ et un port RS-232 pour le 
transfert de fichiers et l'impression. Connectez le terminal PanelView à un réseau DH + au moyen d�un câble 
biaxial Belden 9463 (référence 1770-CD).

Câble
(réf. 2711-NC13, 2711-NC14, 

2706-NC13)

Station 2
Terminal PanelView 1000 RS-232 

Station 0
PC

PanelBuilder32
Station 1

Automate PLC-5

Port PLC DH+

Port RS-232
Port DH+

Bornier de connexion 3 broches
1 Transparent
SH Blindage
2 Bleu

Résistance de terminaison 
 

ControlLogix 5550
Module DH+ SLC 5/04

Port série
(COM1 ou COM2)

Transparent 1
Blindage SH
Bleu 2

Blindage SH
Bleu 2

Transparent 1 Transparent 1
Blindage SH
Bleu 2

82 ou 150 Ohms 
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Configuration du système        13
Connexions DeviceNet
Les terminaux PanelView DeviceNet comportent un port de communication DeviceNet et un port RS-232 pour 
le transfert de fichiers et l'impression. Connectez le terminal PanelView à un réseau DeviceNet au moyen d�un 
câble DeviceNet (référence 1485C-P1A50, -P1A150, -P1A300). La figure suivante présente un automate SLC ou 
PLC. Vous pouvez également utiliser un automate ControlLogix associé à un module 1756-DNB.

 

Bornier 
DeviceNet Borne Signal Fonction Couleur

1 COM Commun Noir

 2 CAN_L Signal Bas Bleu

3 SHIELD Blindage Non isolé

4 CAN_H Signal Haut Blanc

5 VDC+ Alimentation Rouge

Module scrutateur 
DeviceNet

(réf. 1747-SDN)

Câble
(réf. 2711-NC13, 2711-NC14, 

2706-NC13)

Câble (réf. 1485C-P1A50, -P1A150, 
-P1A300)

Module scrutateur
DeviceNet

(réf. 1771-SDN)

Requiert une 
alimentation 24 volts

Automate PLC-5

PanelView 1000SLC 5/03, /04, /05

PanelBuilder32

Port RS-232
Port DeviceNet

5 1

Liaison série

1

5
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14          Configuration du système   
Connexions ControlNet
Les terminaux PanelView ControlNet comportent un port de communication ControlNet et un port RS-232 
pour le transfert de fichiers et l'impression. Connectez le terminal PanelView à un réseau ControlNet au moyen 
d�un câble coaxial BNC (référence 1786-RG6).

 

Port RS-232

Carte KTCX

PLC-5/20C, -5/40C, -5/80C

Câble coaxial BNC

Câble
(réf. 2711-NC13, 2711-NC14, 

2706-NC13)

Câble coaxial BNC

ControlLogix 5550
Module 1756 CNB PanelBuilder32

PanelView 1000

B A

Liaison série
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Configuration du système        15
Connexions EtherNet/IP 
Les versions EtherNet/IP du terminal PanelView comportent toutes deux un port de communication 
Ethernet/IP et un port RS-232 pour le transfert de fichiers et l'impression. Connectez le terminal PanelView à 
un automate ControlLogix (associé à un module 1756-ENET/B ou ENBx), PLC-5E ou SLC 5/05. Le réseau 
EtherNet/IP utilise un câble à paire torsadée blindé et non blindé de catégorie 5 équipé de connecteurs RJ45.

 

Automate ControlLogix 5550

Terminal PanelView
10.0.0.2

Interrupteur

1756-ENET/B
10.0.0.1

Automate PLC-5E
10.0.0.1

Liaison série

Câble
(réf. 2711-NC13, 2711-NC14, 

2706-NC13)

PanelBuilder32

OU

OU

Automate SLC 5/05
10.0.0.1
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16          Configuration du système   
Connexions Modbus 
En version Modbus, les terminaux PanelView sont munis à la fois d�un port de communication Modbus et d�un 
port RS-232 pour le transfert de fichiers et l'impression. Les figures ci-dessous illustrent un terminal PanelView 
Modbus relié à un automate MicroLogix par un câble 2711-NC21 ou -NC22. 

Programme à relais de l’automate
Les programmes logiques à relais de l�automate nécessaires à l�exécution de l�application exemple sont déjà créés. 
Ils se trouvent sur le CD d�installation de PanelBuilder32. Vous trouverez la liste de ces fichiers dans l�annexe A.

MicroLogix 1200/1500 Série C

Référence 2711-NC21 ou -NC22
Câble
Publication 2711-QS003C-FR-P 



Chapitre 2

Présentation de l’application

Ce chapitre traite des points suivants :
• objet de l�application ;
• présentation des vues de l�application ;
• points de l�application.

Objet d’une application
L�application contient des objets qui contrôlent et surveillent l�état d�un moteur. Selon le protocole de 
communication utilisé, le terminal PanelView lit/écrit des données dans l�un des automates suivants :

• automate SLC, MicroLogix, FlexLogix ou CompactLogix sur un réseau DH-485 ;
• automate SLC, PLC-5 ou ControlLogix sur un réseau DH+ ;
• automate SLC, PLC-5 ou ControlLogix sur un réseau RIO ;
• automate SLC, PLC-5, MicroLogix, FlexLogix, CompactLogix ou ControlLogix sur un réseau RS-232 

(DF1) ;
• automate PLC-5 ou SLC sur un réseau DeviceNet ;
• automate ControlLogix ou PLC-5 sur un réseau ControlNet (non prioritaire) ;
• automate ControlLogix sur un réseau ControlNet (prioritaire) ;
• automate ControlLogix, PLC-5E ou SLC 5/05 sur un réseau EtherNet/IP ;
• Automate MicroLogix 1200/1500 Série C sur réseau Modbus. 

Le chapitre 4 présente les procédures de création d�une application sur un terminal PanelView 600 à clavier. 
• S�il s�agit d�une application pour terminal à écran tactile, l�entrée par cellule tactile est automatiquement 

activée et vous n�avez pas à attribuer de touches de fonction.
• Si vous créez une application pour des terminaux d'une autre taille, utilisez une taille de texte appropriée.

Vous pouvez adapter n'importe quelle application exemple à des terminaux PanelView de taille différente. Pour 
savoir comment procéder, reportez-vous à la page 46.
Toutes les applications exemples se trouvent sur le CD d�installation dans le répertoire \QuickStart\PV.
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18        Présentation de l’application 
Vues de l’application
L�application contient 3 vues :

• Etat du moteur : contient des objets servant à démarrer ou à arrêter un moteur, à présenter 
l�état « moteur en marche/moteur arrêté et à afficher sa vitesse courante » ;

• Réglage de la vitesse du moteur : contient un objet d�entrée numérique permettant 
d'indiquer la vitesse maximale du moteur.
Si la vitesse du moteur est modifiée, la nouvelle vitesse ne prend effet qu'une fois le moteur 
arrêté puis redémarré ;

• Bandeau d’alarmes : affichage global s�ouvrant par-dessus la vue Etat du moteur ou la vue 
Réglage de la vitesse du moteur lorsqu�une alarme est déclenchée.

Les vues Etat du moteur et Réglage de la vitesse du moteur comportent un bouton permettant de 
passer d�une vue à l�autre.

Si vous voulez que l�opérateur puisse accéder au menu de configuration à partir d'un terminal à 
écran tactile, placez un bouton Aller à config. sur la vue de l�application. Sur les terminaux pourvus 
uniquement d'un clavier, appuyez simultanément sur les touches fléchées gauche  et droite  
sur le clavier du terminal pour afficher le menu de configuration.
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Présentation de l’application        19
Vue de commande et d’état du moteur

La vue Motor Status (Etat du moteur) apparaît lorsque le terminal est mis sous tension. Elle permet de :
• démarrer ou arrêter un moteur ;
• visualiser l�état moteur en marche/moteur arrêté ;
• visualiser la vitesse du moteur ;
• passer à la vue Set Motor Speed (Réglage de la vitesse du moteur).

Le tableau suivant présente les objets de la vue Motor Status (Etat du moteur) et leurs fonctions. Les 
en-têtes de la vue sont créés comme texte d�arrière-plan.

Objet Type d’objet Fonction

Bouton poussoir momentané
(normalement ouvert)

Fait démarrer le moteur lorsque vous appuyez sur la touche F1 ou 
touchez l’objet de la vue.

Bouton poussoir momentané
(normalement ouvert)

Arrête le moteur lorsque vous appuyez sur la touche F2 ou touchez 
l’objet de la vue.

Indicateur multi-état Indique l’état marche/arrêt du moteur.

Affichage numérique Affiche la vitesse actuelle du moteur.

Bouton Aller à la vue Fait passer à la vue Set Motor Speed (Réglage de la vitesse du moteur) 
lorsque vous appuyez sur la touche F3 ou touchez l’objet de la vue.

Démarrage 
du moteur 

F1

Arrêt
du moteur

F2

Moteur en marche

Moteur arrêté

Vitesse du moteur
####

Vitesse 
du moteur

F3 
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20        Présentation de l’application 
Vue Réglage de la vitesse du moteur

Cette vue permet de :
• définir la vitesse maximale du moteur ;
• passer à la vue Motor Status (Etat du moteur). 

Le tableau suivant présente les objets de la vue Set Motor Speed (Réglage de la vitesse du moteur) et 
leurs fonctions. Les en-têtes de la vue et les étiquettes des objets sont créés comme texte 
d'arrière-plan.

Objet Type d’objet Fonction

Pointeur d’entrée 
numérique

Ouvre le pavé numérique (lorsque vous appuyez sur la touche F1 
ou touchez l’objet de la vue) pour que la vitesse maximale du 
moteur puisse y être entrée (600 à 1800 tpm).

Bouton Aller à la vue Fait passer à la vue Motor Status (Etat du moteur) lorsque vous 
appuyez sur la touche F2 ou touchez l’objet de la vue.

Entrer vitesse maximum :
#### tpm

Etat du 
moteur

F2
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Présentation de l’application        21
Bandeau d’alarmes

Le bandeau d�alarmes est un affichage global qui s'ouvre par-dessus la vue Etat du moteur ou 
Réglage de la vitesse du moteur lorsqu�une alarme est déclenchée. Il affiche un message d�alarme 
lorsque la vitesse du moteur dépasse 1200 tpm et un autre message lorsqu'elle dépasse 1500 tpm.

Le tableau suivant présente les objets du bandeau d�alarmes et leurs fonctions.

Objet Type d’objet Fonction

Texte d’alarme Affiche les messages lorsque la vitesse du moteur atteint 1200 
et 1500 tpm.

Bouton d’acquittement 
des alarmes

Acquitte l’alarme du bandeau lorsque vous appuyez sur la 
touche F4 ou touchez l’objet de la vue.

VITESSE DU MOTEUR ELEVEE !

Acq
F4

VITESSE DU MOTEUR TRES ELEVEE !

VITESSE DU MOTEUR ELEVEE !

Acq
F4
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Points de l’application
L�application exemple requiert 6 points seulement. Chaque point correspond à un groupe de 
paramètres définissant une adresse d�automate. Il est identifié par un nom particulier. 

Voici les points utilisés dans cette application. Ils portent des noms descriptifs pour faciliter la 
création et la modification de l�application.

• Démarrage_du_moteur : attribué au bouton de démarrage du moteur.
• Arrêt_du_moteur : attribué au bouton d�arrêt du moteur.
• Ind_état_moteur : attribué à l�indicateur d�état du moteur.
• Vitesse_moteur : attribué à l�affichage de la vitesse du moteur.
• Vitesse_maxi_moteur : attribué à l�affichage d�entrée numérique pour la vitesse du moteur.
• Alarme_vitesse : attribué au déclenchement pour le bandeau d�alarmes.

Les informations sur les points peuvent être entrées de deux façons :
• Dans la boîte de dialogue Masque du point, à laquelle vous accédez en cliquant sur le bouton 

Editer le point de la boîte de dialogue de l�objet. Permet de modifier tous les champs du point.
• Dans l'éditeur de points, accessible à partir du menu Outils ou du dossier Système de la fenêtre 

d�application. L�éditeur de points affiche tous les points attribués dans l�application et permet de modifier 
leurs champs.

Chaque application a besoin de données de points légèrement différentes selon le protocole de communication 
choisi. Les chapitres 4 et 5 contiennent des informations dont vous avez besoin pour chaque type de terminal et 
fournissent des instructions de saisie de points.
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Chapitre 3

Création de l’application

Suivez les procédures de ce chapitre pour : 
• créer les vues de l�application (Etat du moteur, Réglage de la vitesse du moteur, Bandeau d�alarmes) ;
• sélectionner la vue de démarrage de l�application ;
• enregistrer l'application.

Lancement de PanelBuilder32
Cliquez sur Start (Démarrer) dans la barre des tâches, puis sélectionnez Programs>PanelBuilder32> 
PanelBuilder32.

L'espace de travail de PanelBuilder32 s�ouvre sur la boîte de dialogue de démarrage.
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Création d'une nouvelle application

1. Sélectionnez Create a new application (Créer une nouvelle application) dans la boîte de 
dialogue de démarrage et cliquez sur OK.

2. Dans la boîte de dialogue Create New Application (Créer une nouvelle application), 
attribuez un nom à l�application et sélectionnez un terminal PanelView (type, protocole et type d'entrée 
opérateur).

.

3. Cliquez sur OK pour fermer la boîte de dialogue. 
La fenêtre d�application s�ouvre, portant le nom de l�application dans la barre de titre. Une vue vide 
s�ouvre avec un nom et un numéro par défaut : - Screen 1 (-Vue 1).

Tapez Sample (Exemple)

Sélectionnez le type 
de terminal

Sélectionnez le protocole

Sélectionnez le type d'entrée 
opérateur 

Les vues sont stockées dans 
le dossier Screens (Vues).

Fenêtre 
d'application 
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Pour renommer la Vue 1 (Screen 1) et en modifier la couleur :

1. Sélectionnez Screen>Properties (Vue>Propriétés) ou cliquez avec le bouton droit de la souris sur 
Screen 1 (Vue 1) du dossier Screens (Vues) et sélectionnez Properties (Propriétés) dans le menu 
contextuel.

2. Tapez Motor Status (Etat du moteur) dans le champ Name (Nom) de la boîte de dialogue.

3. Dans la zone Screen Background (Arrière-plan de la vue), sélectionnez White (Blanc) comme 
couleur d�arrière-plan pour la vue.

4. Cliquez sur OK pour fermer la boîte de dialogue.
L�arrière-plan de la vue est maintenant blanc. Le nom de la vue apparaît dans la barre de titre et sur l�icône 
de la vue, dans le dossier Screens (Vues).

Tapez Motor Status
 (Etat du moteur)

SŽlectionnez 
White (Blanc)
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Création de la vue Réglage de la vitesse du moteur
1. Sélectionnez Screen>New (Vue>Nouvelle) ou cliquez avec le bouton droit de la souris sur la vue 

Motor Status (Etat du moteur) du dossier Screens (Vues) et sélectionnez New (Nouvelle).

2. Entrez les propriétés de la vue comme indiqué ci-dessus.

3. Cliquez sur OK pour fermer la boîte de dialogue.
Une vue d�application vide indiquant le numéro de la vue et son nom dans la barre de titre s�ouvre. La 
fenêtre d�application contient également l'icône de la nouvelle vue.

4. Cliquez sur le bouton Réduire pour minimiser la vue Set Motor Speed (Réglage de la vitesse du moteur) 
pendant que vous travaillez sur la vue Motor Status (Etat du moteur). 

Tapez Set Motor Speed 
(Réglage de la vitesse du 
moteur)

Sélectionnez 
White (Blanc)

Bouton Réduire
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Création d’objets dans la vue Etat du moteur  
Création du bouton-poussoir Start Motor (Démarrage du moteur)

1. Sélectionnez Objects>Push Buttons>Momentary (Objets>Boutons poussoirs>Momentané).

2. Positionnez le pointeur (+) dans la partie inférieure gauche de la vue, à l'endroit où vous voulez placer le 
bouton. Faites ensuite glisser le pointeur en maintenant le bouton gauche de la souris enfoncé pour 
dimensionner le bouton.

3. Cliquez deux fois sur l�objet pour ouvrir sa boîte de dialogue et configurer ses propriétés comme indiqué 
ci-dessous.

Remarque : les définitions des points seront entrées au chapitre 5.

Sélectionnez F1

Cliquez sur Single Bit 
(Bit unique)

Tapez Start_Motor 
(Démarrage_du_moteur)
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4. Cliquez sur l�onglet States (Etats) de la boîte de dialogue Push Buttons (Boutons-poussoirs).
Chaque ligne définit le texte et les options de formatage d'un état du bouton-poussoir. La ligne 0 
représente l�état 0, la ligne 1, l�état 1. Les textes par défaut d'un bouton-poussoir à 2 états sont ST 0 (Etat 
0) et ST 1 (Etat 1).

5. Pour chaque ligne, cliquez deux fois dans le champ Message Text (Texte du message) et modifiez le texte 
comme indiqué ci-dessous. Modifiez également les couleurs par défaut de l�objet et du texte.

6. Cliquez sur OK pour fermer la boîte de dialogue. Une icône du bouton-poussoir est placée sur la touche 
F1 pour indiquer que la touche est attribuée à un objet.
Vous verrez un astérisque (*) si la zone est trop petite pour le texte. Sélectionnez l�objet, puis faites glisser 
l�une des poignées pour redimensionner la zone jusqu�à ce que le texte y tienne.

Etat 0
Etat 1

Sélectionnez White (Blanc) pour l'arrière-plan du texte

Sélectionnez Blue (Bleu) pour le premier plan de l’objet

Sélectionnez Blue (Bleu) pour le premier plan du texte

Sélectionnez White (Blanc) pour l'arrière-plan de l’objet

Appuyez sur Entrée pour commencer une nouvelle ligne. /*R*/ indique un retour chariot.

Démarrage
du moteur

F1

Moteur
en marche

Etat 0 Etat 1

Démarrage
du moteur*
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Création du bouton-poussoir Stop Motor (Arrêt du moteur)

Utilisez les commandes Copier et Coller pour créer le bouton-poussoir Stop Motor (Arrêt du moteur).

1. Cliquez sur le bouton Start Motor (Démarrage du moteur) avec le bouton gauche de la souris (pour le 
sélectionner).

2. Sélectionnez Edition>Copier ou cliquez sur l�outil Copier de la barre d�outils.

3. Sélectionnez Edition>Coller ou cliquez sur l�outil Coller de la barre d�outils.
Le bouton présente alors un contour.

4. Faites glisser ce contour vers la droite du bouton-poussoir Start Motor (Démarrage du moteur), puis 
cliquez sur le bouton gauche de la souris pour coller le bouton-poussoir dans la vue.

5. Cliquez deux fois sur le bouton que vous venez de coller pour ouvrir sa boîte de dialogue et configurer les 
propriétés indiquées ci-dessous.

Les icônes sur les touches F1 et F2 
indiquent que ces touches sont 
actuellement affectées à des objets.

Remplacez Start_Motor 
(Démarrage_du_moteur) par 
Stop Motor (Arrêt_du_moteur)

Sélectionnez F2
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6. Cliquez sur l�onglet States (Etats) de la boîte de dialogue Push Buttons (Boutons-poussoirs).

7. Pour chaque ligne, cliquez deux fois dans le champ Message Text (Texte du message) et remplacez le 
texte comme indiqué ci-dessous.

8. Cliquez sur OK pour fermer la boîte de dialogue.

N’oubliez pas que /*R*/ indique un retour chariot.

Arrêt
du moteur

F2

Moteur
arrêté

Etat 0 Etat 1
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Création du bouton Vitesse du moteur

1. Sélectionnez Objects>Screen Selectors>Goto (Objets>Sélecteurs de vues>Aller à).

2. Positionnez le pointeur (+) dans la partie inférieure droite de la vue, à l'endroit où vous voulez placer le 
bouton. Faites ensuite glisser le pointeur en maintenant le bouton gauche de la souris enfoncé pour 
dimensionner le bouton.

3. Sélectionnez Format>Basculer premier/arrière-plan pour inverser les couleurs de l�objet.

4. Sélectionnez Format>Texte intérieur ou cliquez sur l�outil Texte intérieur.
La barre d�outils Texte Intérieur s�ouvre, affichant le texte par défaut du bouton.

Suggestion : cliquez sur la flèche à droite de la zone de texte pour ouvrir la boîte de dialogue d�édition 
du texte.

5. Remplacez le texte par défaut par Motor Speed (Vitesse du moteur) comme indiqué ci-dessous. Le texte 
est entré dans l'objet au fur et à mesure que vous le modifiez.

6. Cliquez n�importe où hors de l�objet pour quitter le mode texte intérieur.

La touche F3 affiche maintenant une icône pour indiquer qu�elle est attribuée à un objet.

Bouton Aller à la vue

Vitesse
du moteur

F3
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7. Cliquez deux fois sur le bouton Motor Speed (Vitesse du moteur).

8. Sélectionnez les propriétés comme indiqué ci-dessous.

9. Cliquez sur OK pour fermer la boîte de dialogue.

Création de l’affichage Vitesse du moteur

1. Sélectionnez Objets>Affichage numérique.

2. Positionnez le pointeur (+) au-dessus du bouton Motor Speed (Vitesse du moteur). Faites ensuite glisser 
le pointeur en maintenant le bouton gauche de la souris enfoncé pour dimensionner le bouton.
L�objet est créé avec les caractères ###### servant de marque de réservation pour la valeur numérique. 
Chaque # représente un chiffre. La largeur de champ initiale est de 6 chiffres.

3. Sélectionnez Format>Basculer premier/arrière-plan pour inverser les couleurs de l�objet.

Sélectionnez Set Motor Speed (Réglage de la vitesse du moteur)

C’est la vue qui s’ouvre lorsque l’opérateur 
appuie sur la touche F3 dans la vue Motor 
Status (Etat du moteur).

Affichage numérique

Texte

####
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4. Cliquez deux fois sur un objet pour ouvrir sa boîte de dialogue. Entrez les propriétés comme indiqué 
ci-dessous.

5. Cliquez sur OK pour fermer la boîte de dialogue. 
La largeur de champ maximale de la valeur numérique est maintenant de quatre caractères ####.

6. Sélectionnez Objets>Texte pour créer l�étiquette Motor_Speed (Vitesse du moteur).

7. Positionnez le pointeur (+) au-dessus de l�affichage numérique et faites glisser le pointeur en maintenant 
enfoncé le bouton gauche de la souris pour dessiner la zone de texte. Vous êtes placé en mode texte.

8. Saisissez Motor Speed (Vitesse du moteur) comme indiqué ci-dessous. Le texte est entré dans l'objet au 
fur et à mesure que vous le saisissez.

9. Cliquez sur l�icône Basculer premier/arrière-plan pour inverser les couleurs du texte.

Sélectionnez 4

Tapez Motor_Speed 
(Vitesse_du_moteur)
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Création de l’indicateur Etat du moteur

1. Sélectionnez Objects>Indicator>Multistate (Objets>Indicateurs>Multi-état).

2. Positionnez le pointeur (+) au-dessus des boutons-poussoirs Start Motor (Démarrage du moteur) et Stop 
Motor (Arrêt du moteur) et faites glisser le pointeur en maintenant le bouton gauche de la souris enfoncé 
pour dimensionner le bouton.

3. Sélectionnez Format>Basculer premier/arrière-plan pour inverser les couleurs de l�objet.

4. Cliquez deux fois sur l�objet pour ouvrir sa boîte de dialogue, puis cliquez sur l�onglet States (Etats). 
Chaque ligne définit le texte et les options de formatage d'un état de l�indicateur. La ligne 0 représente 
l�état 0, la ligne 1, l�état 1. Le texte par défaut d'un indicateur multi-état est ETAT 0, ETAT 1, ETAT 2, 
ETAT 3. Les indicateurs sont initialement créés avec 4 états (ETAT 0 - ETAT 3).

5. Sélectionnez les lignes 2 et 3 (sélectionnez la ligne 2, puis cliquez sur la ligne 3 en maintenant la touche 
Maj enfoncée). Cliquez sur le bouton droit de la souris et sélectionnez Delete State (Supprimer 
l’état) dans le menu contextuel.

Indicateur multi-état
Moteur arrêté

Vitesse du moteur
####

Etat 0

Etat 0

Etat 1
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6. Cliquez deux fois dans le champ Message Text (Texte du message) des lignes 0 et 1 et modifiez le texte 
comme indiqué ci-dessous. 

7. Cliquez sur l�onglet Properties (Propriétés) et configurez les propriétés comme indiqué ci-dessous.

Remarque : du fait que l'option Single Bit (Bit unique) ne prend en charge que 2 états (Etat 0 et 
Etat 1), vous devez supprimer les états supplémentaires dans l'onglet States (Etats) avant de 
sélectionner Single Bit (Bit unique) dans l'onglet Properties (Propriétés).

8. Cliquez sur OK pour fermer la boîte de dialogue.

Moteur arrêté

Etat 0

Moteur en marche

Etat 1

Etat d’erreur : si un état d’erreur se produit, aucun état n’est mis en surbrillance.

Tapez Motor_Status_Ind (Ind_état_moteur)

Cliquez sur Single Bit 
(Bit unique)
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Création du titre de la vue Etat du moteur

1. Sélectionnez Objects>Text (Objets>Texte).

2. Positionnez le pointeur (+) en haut de la vue et faites glisser le pointeur en maintenant le bouton gauche 
de la souris enfoncé pour dessiner une zone de texte. Vous êtes en mode texte.

3. Saisissez MOTOR STATUS SCREEN (VUE ETAT DU MOTEUR) comme indiqué ci-dessous. Le 
texte est entré dans l'objet au fur et à mesure que vous le saisissez.

4. Cliquez sur l�outil Basculer premier/arrière-plan pour inverser les couleurs de premier plan et 
d�arrière-plan de l�objet.

5. Cliquez sur l'outil Taille du texte et choisissez 8 x 24 dans le menu.

6. Désélectionnez l�objet en cliquant au-dehors.
Suggestion : un astérisque apparaît (*) si la zone est trop petite pour le texte. Sélectionnez l�objet puis faites 
glisser l'une des poignées pour redimensionner la zone jusqu�à ce que le texte y tienne.

IMPORTANT Sélectionnez Réorganiser>Placer les objets dynamiques devant pour placer 
tous les objets de contrôle devant les autres objets. Ainsi, les objets de contrôle 
ne seront pas recouverts par des objets statiques tels que du texte.

En-t•te de la vue
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Création d’objets dans la vue Réglage de la vitesse du moteur  

Création d’un objet d’entrée numérique pour configurer la vitesse du moteur

1. Ouvrez la vue Set Motor Speed (Réglage de la vitesse du moteur) (Vue 2) en cliquant sur la barre de titre 
de la vue minimisée. 

2. Sélectionnez Objects>Numeric Entry>Cursor Point (Objets>Entrée 
numérique>Pointeur).

3. Positionnez le pointeur (+) au milieu de la vue et faites glisser le pointeur en maintenant le bouton gauche 
de la souris enfoncé pour dessiner l�objet. 
L�objet est créé avec six caractères ###### servant de marque de réservation pour la valeur numérique. 
Chaque # représente un chiffre. La largeur de champ initiale est de 6 chiffres.

4. Sélectionnez Format>Basculer premier/arrière-plan pour inverser les couleurs de l�objet.

Pointeur d’entrée numérique

######
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5. Cliquez deux fois sur l�objet pour configurer ses propriétés comme indiqué ci-dessous.

6. Cliquez sur OK pour fermer la boîte de dialogue.
La largeur de champ maximale de la valeur numérique est de quatre caractères ####.

7. Sélectionnez Objets>Texte.

8. Positionnez le pointeur (+) au-dessus de l�objet d�entrée numérique et faites glisser le pointeur en 
maintenant le bouton gauche de la souris enfoncé pour dessiner une zone de texte. Vous êtes en mode 
texte.

9. Saisissez Enter Maximum Speed (Entrer vitesse maximum) comme indiqué ci-dessous. Le texte est entré 
dans l'objet au fur et à mesure que vous le saisissez.

10. Cliquez sur l�outil Basculer premier/arrière-plan pour inverser les couleurs de premier plan et 
d�arrière-plan de l�objet.

11. Désélectionnez l�objet en cliquant au-dehors.
Suggestion : un astérisque apparaît (*) si la zone est trop petite pour le texte. Sélectionnez l�objet puis faites 
glisser l'une des poignées pour redimensionner la zone jusqu�à ce que le texte y tienne.

Tapez Set_Max_Motor_Speed 
(Vitesse_maxi_moteur)

Sélectionnez 4
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Création du bouton Etat du moteur

Pour créer le bouton de vue Motor Status (Etat du moteur), copiez le bouton Motor Speed (Vitesse du moteur) 
de la vue 1 et modifiez ses propriétés.

1. Sélectionnez le bouton Motor Speed (Vitesse du moteur) dans la vue Motor Status (Etat du moteur) 
(cliquez n�importe où dans la vue pour l�activer).

2. Sélectionnez Edition>Copier ou cliquez sur l�outil Copier de la barre d�outils.

3. Cliquez dans la vue Set Motor Speed (Réglage de la vitesse du moteur) (vue 2).

4. Sélectionnez Edition>Coller ou cliquez sur l�outil Coller de la barre d�outils.
Le bouton présente alors un contour.

5. Faites glisser ce contour vers la partie inférieure droite de la vue et cliquez sur le bouton gauche de la 
souris pour coller le bouton dans la vue.

6. Cliquez sur l�outil Texte intérieur pour modifier le texte du bouton. Remplacez le texte par Motor 
Status (Etat du moteur) comme indiqué ci-dessous.

7. Cliquez deux fois sur l�objet pour ouvrir sa boîte de dialogue.

8. Cliquez sur OK pour fermer la boîte de dialogue.

Vitesse
du moteur

F3

Modifiez le texte de cette façon.

Sélectionnez Goto Specific Screen 
(Aller à une vue spécifique)

Sélectionnez Motor Status (Etat du moteur)

C’est la vue qui s’ouvre lorsque l’opérateur 
appuie sur la touche F2 dans la vue Set Motor 
Speed (Réglage de la vitesse du moteur).
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Création du titre de la vue Réglage de la vitesse du moteur

1. Sélectionnez Objets>Texte.

2. Positionnez le pointeur (+) en haut de la vue et faites glisser le pointeur en maintenant le bouton gauche de 
la souris enfoncé pour dessiner une zone de texte. Vous êtes en mode texte.

3. Saisissez Enter Maximum Speed (Entrer vitesse maximum) comme indiqué ci-dessous. Le texte est entré 
dans l'objet au fur et à mesure que vous le saisissez.

4. Cliquez sur l�outil Basculer premier/arrière-plan pour inverser les couleurs de premier plan et 
d�arrière-plan de l�objet.

5. Cliquez sur l'outil Taille du texte et choisissez 8 x 24 dans le menu.

6. Désélectionnez l�objet en cliquant au-dehors.

Suggestion : un astérisque apparaît (*) si la zone est trop petite pour le texte. Sélectionnez l�objet, puis 
faites glisser l'une des poignées pour redimensionner la zone jusqu�à ce que le texte y tienne.

Création du bouton Aller à config.
Cette section s'applique aux terminaux pourvus uniquement d'un écran tactile. Si vous créez l�application 
exemple pour un terminal à clavier, passez directement à la section suivante.
Sur les terminaux sans clavier, le bouton Aller à config. permet à l�opérateur d�accéder au menu de configuration.

1. Sélectionnez Objets>Sélecteurs de vues>Aller à config.

2. Sur chaque vue, positionnez le pointeur (+) à gauche du bouton. Faites ensuite glisser le pointeur en 
maintenant le bouton gauche de la souris enfoncé pour dessiner l�objet.

3. Sélectionnez Format>Basculer premier/arrière-plan pour inverser les couleurs de l�objet.

IMPORTANT Sélectionnez Réorganiser>Placer les objets dynamiques devant pour placer 
tous les objets de contrôle devant les autres objets. Ainsi, les objets de contrôle 
ne seront pas recouverts par des objets statiques tels que du texte.

Vue Etat du moteur Vue Réglage de la vitesse du moteur

Démarrage 
du moteur

Arrêt
du moteur

Aller à
config.

Vitesse du 
moteur

Aller à
config.

Etat du 
moteur
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Création du bandeau d’alarmes et des messages d’alarme
Dans cette section, vous allez créer :

• un bandeau d�alarmes s�ouvrant par-dessus la vue active lorsqu�une alarme est déclenchée. Il contient une 
zone d'affichage de messages et un bouton d�acquittement ;

• un point de déclenchement d�alarmes, définissant l�adresse à laquelle l�automate écrit un bit pour 
déclencher une alarme ;

• les messages devant apparaître dans le bandeau lorsqu'une alarme est déclenchée. 

Création du bandeau d’alarmes

1. Sélectionnez Vue>Créer le bandeau d'alarmes.
Le bandeau d�alarmes est créé dans le dossier Screens (Vues). Il apparaît avec une zone d'affichage de 
messages et un bouton de suppression des alarmes.

2. Pour réduire la hauteur du bandeau, cliquez sur la poignée inférieure pour la remonter.

3. Cliquez au-dehors du bandeau pour le désélectionner.

4. Cliquez sur le bouton Supprimer, puis sélectionnez Edition>Couper ou sélectionnez l�outil Couper.

5. Sélectionnez Objets>Boutons d’alarmes>Acquitter.

6. Positionnez le pointeur (+) dans le bandeau et cliquez sur le bouton gauche de la souris pour placer 
l�objet.

7. Cliquez deux fois sur le bouton d�acquittement d�alarme pour ouvrir sa boîte de dialogue. Sélectionnez la 
touche F4.

Supprimer

Sur les terminaux couleur, 
l’arrière-plan est rouge et le premier 
plan est blanc. Sur les terminaux 
monochromes, l’arrière-plan est 
blanc et le premier plan est noir.

Sélectionnez F4
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8. Cliquez sur OK pour fermer la boîte de dialogue.

9. Sélectionnez Format>Texte intérieur et entrez Acq/*R*/F4 dans la zone de texte.

Définition d’un déclenchement d’alarmes

Dans cette section, vous allez définir un point de déclenchement. Lorsqu'une condition d�alarme se produit, une 
valeur est envoyée à l�adresse du point de déclenchement. 

1. Cliquez deux fois sur l�icône Alarm Triggers (Déclenchements d’alarmes) dans le dossier 
Alarms.

Ou sélectionnez Application>Config. alarmes, puis sélectionnez l�onglet Déclenchements 
d’alarmes.

2. Saisissez Speed_Alarm (Alarme_vitesse) dans le champ Trigger Tag (Point de 
déclenchement).

3. Sélectionnez Bit dans le champ Trigger Type (Type de déclenchement).

Définition des messages d’alarmes

1. Sélectionnez l�onglet Alarm Messages (Messages d’alarmes) dans la boîte de dialogue Alarmes.
Chaque ligne définit un message d�alarme et ses attributs. 
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2. Pour ajouter une ligne, cliquez sur le bouton droit de la souris et sélectionnez Append Alarm 
(Ajouter une alarme) dans le menu contextuel.

3. Pour chaque ligne, modifiez les attributs comme suit :
– cliquez deux fois dans le champ Message Text (Texte du message) et saisissez le message d�alarme ;
– cliquez deux fois dans champ Value/Bit (Valeur/Bit) (offset de bit) et entrez la valeur indiquée ;
– cochez la case du champ Ack (Acq).

4. Cliquez sur OK pour fermer la boîte de dialogue Alarmes.

Les messages d�alarmes déclenchés sur bit sont définis par un offset de bit (champ Valeur/Bit) à l'adresse du 
point de déclenchement. Par exemple, si l�adresse du point de déclenchement est définie comme étant B3:1/0, 
les messages d�alarmes peuvent être déclenchés à partir des adresses B3:1/1 et B3:1/2.

• Lorsque la vitesse du moteur atteint 1200 tpm, l�automate met à 1 le bit B3:1/2, déclenchant une 
condition d�alarme. Le message MOTOR SPEED HIGH! (VITESSE DU MOTEUR ÉLEVÉE !) 
apparaît dans le bandeau d�alarmes.

• Lorsque la vitesse du moteur atteint 1500 tpm, l�automate met à 1 le bit B3:1/1, déclenchant une 
condition d�alarme. Le message MOTOR SPEED HIGH HIGH! (VITESSE DU MOTEUR TRÈS 
ÉLEVÉE !) apparaît dans le bandeau d�alarmes.

Champs à éditer

B3:1/0 +                          2 =

Adresse du point de déclenchement Valeur/Bit du message d’alarme

B3:1/2

Adresse de l’automate

B3:1/0 + 1 =

Adresse du point de déclenchement Valeur/Bit du message d’alarme

B3:1/1

Adresse de l’automate
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Fermeture des vues
Fermez les vues en cliquant sur le X dans la barre de titre, ou en sélectionnant Vue>Fermer. 

Pour fermer toutes les vues, sélectionnez Fenêtre>Fermer toutes les vues.

Définition de la vue de démarrage de l’application

1. Sélectionnez Application>Configuration.

2. Sélectionnez l�onglet Power-Up (Mise ss tension).

3. Sélectionnez Motor Status (Etat du moteur) dans la liste de Startup Screen (Vue de 
démarrage).

4. Cliquez sur OK pour fermer la boîte de dialogue.

Sélectionnez Motor Status 
(Etat du moteur)
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Enregistrement de l’application

1. Sélectionnez Fichier>Enregistrer ou cliquez sur l�icône Enregistrer de la barre d�outils.

Le fichier est enregistré à l�emplacement par défaut, dans un fichier portant le nom de l'application et 
l'extension .PBA. 

2. Cliquez sur le bouton Enregistrer pour enregistrer l�application et la fermer.

Le fichier est enregistré dans Program Files>Allen-Bradley>PanelBuilder32>Applications.

Remarque : lorsque vous sélectionnez Fichier>Enregistrer la fois suivante, la boîte de dialogue 
Enregistrer sous ne s�ouvre pas. Le fichier est enregistré avec le nom de l�application et l'extension .PBA.
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Conversion de l’application pour un type de terminal différent
L�application exemple a été créée pour le terminal PanelView 600 à clavier. Elle peut être utilisée avec les 
protocoles DH-485, DH+, DF1, RIO, DeviceNet, EtherNet/IP, ControlNet et Modbus.Suivez la procédure 
ci-dessous pour adapter l�une de ces applications à un terminal de taille différente, le PanelView 1000 par 
exemple. 

1. Sélectionnez Application>Configuration.
2. Ouvrez l�onglet Terminal Setup (Configuration du terminal).
3. Sélectionnez le terminal PanelView pour lequel vous souhaitez convertir l�application.

4. Lorsque vous cliquez sur OK, l�application est convertie et validée.
Si la conversion de l�application est réussie, la fenêtre de résultats affiche le message :

          [Application] Conversion réussie - Pas d'erreurs.

Si le terminal utilise un protocole différent, vous pouvez sélectionner l�option Conversion dans l'onglet 
Edition de points de la boîte de dialogue Outils>Options. L�éditeur de points convertira les points pour les 
adapter au nouveau protocole. Il vous faudra toutefois mettre à jour les données de ces points.

IMPORTANT Vous devrez peut-être déplacer et redimensionner les objets  et 
ajuster la taille du texte en fonction de la taille du terminal.
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Chapitre 4

Configuration des communications

Ce chapitre explique comment configurer les communications réseau du terminal PanelView et de l�automate, et 
présente la configuration des protocoles de communication suivants : 

• DH-485 : configuration d�un terminal PanelView DH-485 et d�un automate SLC ou MicroLogix.

• DH+ : configuration d�un terminal PanelView DH+ et d�un automate PLC-5, SLC 5/04 ou 
ControlLogix avec un module DH+.

• RIO : configuration d�un terminal RIO et d�un automate PLC 5, SLC 5/03, 5/04, 5/05 avec un 
scrutateur 1747-SN/B ou d�un automate ControlLogix avec un module DHRIO.

• ControlNet : configuration d�un terminal PanelView ControlNet et d�un automate ControlLogix avec 
un module ControlNet ou d'un automate PLC-5 via la messagerie prioritaire ou non prioritaire.

• DeviceNet : configuration d'un terminal PanelView DeviceNet pour communiquer en tant 
qu'équipement esclave avec un automate PLC-5, SLC ou ControlLogix avec un module DeviceNet.

• EtherNet/IP : configuration d'un terminal PanelView EtherNet/IP pour communiquer avec un 
automate ControlLogix (avec un module 1756-ENET/B ou /ENBx), PLC-5E ou SLC 5/05 sur un 
réseau EtherNet/IP.

• DF1 : configuration d�un terminal PanelView DF1 et d�un automate PLC-5, SLC 5/03, 5/04, 5/05, 
MicroLogix ou ControlLogix. Pour un port série ControlLogix, sélectionnez le type d'automate PLC-5.

• Modbus - permet de configurer un terminal PanelView Modbus et un automate MicroLogix 1200/1500 
Série C. 

Consultez la section correspondant à votre type de terminal. 
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Configuration de la communication DH-485
Cette section définit les paramètres de communication applicables à un terminal PanelView DH-485 et à un 
automate sur un réseau DH-485.

1. Sélectionnez Application>Configuration.

2. Sélectionnez l�onglet Terminal Setup (Configuration du terminal).

3. Cliquez sur le bouton Comms. Setup (Config. Comm) et définissez les paramètres comme indiqué 
ci-dessous.
Pour ajouter une station de réseau, cliquez avec le bouton droit de la souris dans le champ Node Name 
(Nom de station). Complétez les champs Node Name (Nom de station), Node Address 
(Adresse de station) et Node Type (Type de station) de l�automate utilisé.

4. Cliquez sur OK dans toutes les vues ouvertes pour fermer la boîte de dialogue Application Settings 
(Configuration de l’application).

Important : vérifiez que la 
référence et le numéro de révision 
du firmware correspondent bien à 
votre terminal.

Sélectionnez l’automate 
utilisé.

Important : LC_1 correspond 
au nom de station entré dans 
l’éditeur de points. 
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Configuration de la communication DH+
Cette section définit les paramètres de communication applicables à un terminal PanelView DH+ et à un 
automate sur un réseau DH+.

1. Sélectionnez Application>Configuration.

2. Sélectionnez l�onglet Terminal Setup (Configuration du terminal).

3. Cliquez sur le bouton Comms. Setup (Config. Comm).

4. Définissez les paramètres comme indiqué ci-dessous. 
Pour ajouter une station de réseau, cliquez avec le bouton droit de la souris dans le champ Node Name 
(Nom de station). Complétez les champs Node Name (Nom de station), Node Address 
(Adresse de station) et Node Type (Type de station) de l�automate utilisé.

5. Cliquez sur OK dans toutes les vues ouvertes pour fermer la boîte de dialogue Application Settings 
(Configuration de l’application).

IMPORTANT Pour l'automate ControLogix, sélectionnez PLC-5 
comme type de station.

Important : LC_1 correspond au 
nom de station entré dans 
l’éditeur de points. 

Vérifiez que le numéro de révision du firmware 
correspond bien à votre terminal.

Sélectionnez l’automate 
utilisé.
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Configuration de la communication RIO
Cette section définit les paramètres de communication applicables à un terminal PanelView RIO et à un 
automate sur un réseau RIO.

1. Sélectionnez Application>Configuration.

2. Dans l'onglet Terminal Setup (Configuration du terminal), cliquez sur le bouton Comms. 
Setup (Config. Comm) et définissez les paramètres comme indiqué ci-dessous :

 

3. Cliquez sur OK dans toutes les vues ouvertes pour fermer la boîte de dialogue Application Settings 
(Configuration de l’application).

Important : LC_1 
correspond au nom de 
station entré dans 
l’éditeur de points. 

Sélectionnez un automate :
- SLC 5/04 avec module scrutateur 
1747-SN/B
- ControlLogix avec module DHRIO

Vérifiez que le numéro de révision du 
firmware correspond bien à votre terminal.
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Configuration de la communication DeviceNet
Cette section définit les paramètres de communication applicables à un terminal PanelView DeviceNet 
fonctionnant comme équipement esclave sur un réseau DeviceNet.

1. Sélectionnez Application>Configuration.

2. Dans l'onglet Terminal Setup (Configuration du terminal), cliquez sur le bouton Comms. 
Setup (Config. Comm) et définissez les paramètres comme indiqué ci-dessous :

 

3. Cliquez sur OK dans toutes les vues ouvertes pour fermer la boîte de dialogue Application Settings 
(Configuration de l’application).

Vérifiez que la référence et le numéro de révision 
du firmware correspondent bien à votre terminal.

Type 2 Type 3
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Configuration de la communication ControlNet
Cette section définit les paramètres de communication applicables à un terminal PanelView ControlNet et à un 
automate ControlLogix sur un réseau ControlNet.

1. Sélectionnez Application>Configuration.

2. Dans l'onglet Terminal Setup (Configuration du terminal), cliquez sur le bouton Comms. 
Setup (Config. Comm) et définissez les paramètres comme indiqué ci-dessous :

 

3. Cliquez sur OK dans toutes les vues ouvertes pour fermer la boîte de dialogue Application Settings 
(Configuration de l’application).

Important : LC_1 
correspond au nom de 
station entré dans 
l’éditeur de points. 

Sélectionnez l’automate 
utilisé.

Vérifiez que la référence et le numéro de révision 
du firmware correspondent bien à votre terminal.

1 pour un PLC Allen-Bradley
1  1  0  pour ControlLogix :

1  correspondant au numéro de station 1784-CNB (de 1 à 99)
1  correspondant au numéro du fond de panier du ControlLogix
0  correspondant au numéro d'emplacement du ControlLogix

Vous devez entrer un espace entre les numéros, comme indiqué.
Publication 2711-QS003C-FR-P 



Configuration des communications        53
Configuration de la communication EtherNet/IP 
Cette section définit les paramètres de communication applicables à un terminal PanelView EtherNet/IP et à un 
automate ControlLogix sur un réseau Ethernet/IP. 

1. Sélectionnez Application>Configuration.

2. Dans l'onglet Terminal Setup (Configuration du terminal), cliquez sur le bouton Comms. 
Setup (Config. Comm) et définissez les paramètres comme indiqué ci-dessous :

3. Cliquez sur OK dans toutes les vues ouvertes pour fermer la boîte de dialogue Application Settings 
(Configuration de l’application).

Complétez les champs Node 
Address (adresse), Path (chemin) 
et Node Type (type de station) 
comme indiqué. 

Vérifiez que la référence et le numéro de révision 
du firmware correspondent bien à votre terminal.

Important : LC_1 
correspond au nom de 
station entré dans 
l’éditeur de points. 

Cliquez sur le bouton Config Ethernet. 
Définissez les paramètres comme indiqué.
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Configuration de la communication DF1
Cette section définit les paramètres de communication applicables à un terminal PanelView DF1 et à un 
automate PLC 5 ou SLC 5/03, /04, /05 sur le canal 0.

1. Sélectionnez Application>Configuration.

2. Dans l'onglet Terminal Setup (Configuration du terminal), cliquez sur le bouton Comms. 
Setup (Config. Comm) et définissez les paramètres comme indiqué ci-dessous :

 

3. Cliquez sur OK dans toutes les vues ouvertes pour fermer la boîte de dialogue Application Settings 
(Configuration de l’application).

Important : LC_1 correspond 
au nom de station entré dans 
l’éditeur de points. 

Sélectionnez l’automate utilisé.

Vérifiez que la référence et le numéro de révision 
du firmware correspondent bien à votre terminal.
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Configuration des communications Modbus
Cette section permet de définir les paramètres de communication à utiliser avec un terminal PanelView Modbus 
et un automate MicroLogix.

1. Sélectionnez Application>Configuration.

2. Dans l'onglet Setup (Configuration du terminal), cliquez sur le bouton Comms. Setup 
(Config. Comm.) et définissez les propriétés comme indiqué ci-dessous :

Enregistrement de l’application
Sélectionnez Fichier>Enregistrer ou cliquez sur l�outil Enregistrer de la barre d�outils.

Important : 
LC_1 correspond au nom de station entré dans 
l’éditeur de points. 

Sélectionnez Modbus comme 
type de station.

Assurez-vous que la référence et le numéro de 
firmware correspondent bien à votre terminal.
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Chapitre 5

Saisie des points de l’application

Ce chapitre explique comment : 
• ouvrir l�éditeur de points ;
• entrer des points dans la fiche de configuration pour chaque protocole de communication ;
• enregistrer les points.

Ouverture de l’éditeur de points
Pour ouvrir l’éditeur de points :

• Sélectionnez Outils>Editeur de points

• ou ouvrez le dossier Système dans la fenêtre d�application et cliquez deux fois sur l�icône Editeur de 
points.
Une fiche de configuration vide s�ouvre. Elle est munie d�un onglet portant le nom du protocole. 
L�éditeur de points possède ses propres barre de menus et barre d�outils ; celles-ci restent actives tant que 
l�éditeur de points est ouvert.

Fait défiler les onglets 
vers la droite ou vers la gauche

Fait défiler les colonnes 
vers la droite ou vers la gauche

Onglet identifiant le 
protocole

Champs de 
points
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Description des points de l’application

Points de l’application DH-485, DH+ ou DF1

Le tableau ci-dessous répertorie les points d�application utilisés par les applications DH-485, DH+ et DF1. Les 
champs qui n'y figurent pas acceptent les valeurs par défaut. Ces points sont également utilisés pour 
EtherNet/IP (vers un automate PLC-5E ou SLC) et ControlNet (vers un automate PLC-5C).

Points de l’application RIO

Le tableau ci-dessous répertorie les points d�application utilisés par l�application RIO. Les champs qui n'y 
figurent pas acceptent les valeurs par défaut.

Nom du point Type de 
données Adresse Description Nom de 

station
Valeur 
initiale Min Max

Démarrage_du_moteur Bit B3:0/0 Fait démarrer le moteur LC_1 0 0 0

Arrêt_du_moteur Bit B3:0/1 Arrête le moteur LC_1 0 0 0

Ind_état_moteur Bit B3:0/2 Moteur en marche/moteur 
arrêté

LC_1 0 0 0

Vitesse_du_moteur Entier non signé N7:0 Indique la vitesse du moteur LC_1 0 0 65535

Vitesse_maxi_moteur Entier non signé N7:1 Définit la vitesse maximale LC_1 1800 600 1800

Alarme_vitesse Bit B3:1/0 Déclenche les messages 
d’alarmes

LC_1 0 0 0

Nom du point Type de 
données Adresse Description Nom de 

station
Valeur 
initiale Min Max

Démarrage_du_moteur Bit I:010/0 Fait démarrer le moteur LC_1 0 0 0

Arrêt_du_moteur Bit I:010/1 Arrête le moteur LC_1 0 0 0

Ind_état_moteur Bit O:010/0 Moteur en marche/moteur 
arrêté

LC_1 0 0 0

Vitesse_du_moteur Entier non signé O:011 Indique la vitesse du moteur LC_1 0 0 65535

Vitesse_maxi_moteur Entier non signé I:011 Définit la vitesse maximale LC_1 1800 600 1800

Alarme_vitesse Bit O:012/0 Déclenche les messages 
d’alarmes

LC_1 0 0 0
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Points de l’application ControlNet non prioritaire

Le tableau ci-dessous répertorie les points d�application utilisés par l�application ControlNet avec la messagerie 
non prioritaire. Remarque : les points ci-dessous sont destinés à une application ControlLogix. Les champs 
qui n'y figurent pas acceptent les valeurs par défaut.

Points de l’application ControlNet prioritaire

Le tableau ci-dessous répertorie les points d�application utilisés par l�application ControlNet avec la messagerie 
prioritaire. Les champs qui n'y figurent pas acceptent les valeurs par défaut.

Nom du point Type de 
données Adresse Description Nom de 

station
Valeur 
initiale Min Max

Démarrage_du_moteur Bit Motor_Control.00 Fait démarrer le 
moteur

LC_1 0 0 0

Arrêt_du_moteur Bit Motor_Control.01 Arrête le moteur LC_1 0 0 0

Ind_état_moteur Bit Motor_Control.02 Moteur en 
marche/moteur arrêté

LC_1 0 0 0

Vitesse_du_moteur Entier 
signé/INT

Motor_Speed[0] Indique la vitesse du 
moteur

LC_1 0 0 65535

Vitesse_maxi_moteur Entier 
signé/INT

Motor_Speed[1] Définit la vitesse 
maximale

LC_1 1800 600 1800

Alarme_vitesse Bit Alarms.00 Déclenche les 
messages d’alarmes

LC_1 0 0 0

Nom du point Type de 
données Adresse Description Nom de station Valeur 

initiale Min Max

Démarrage_du_moteur Bit SI0:0/0 Fait démarrer le 
moteur

ControlNet_Scheduled_
File

0 0 0

Arrêt_du_moteur Bit SI0:0/1 Arrête le moteur ControlNet_Scheduled_
File

0 0 0

Ind_état_moteur Bit SO0:0/0 Moteur en 
marche/moteur 
arrêté

ControlNet_Scheduled_
File

0 0 0

Vitesse_du_moteur Entier 
signé/INT

SO0:1 Indique la vitesse 
du moteur

ControlNet_Scheduled_
File

0 0 65535

Vitesse_maxi_moteur Entier 
signé/INT

SI0:1 Définit la vitesse 
maximale

ControlNet_Scheduled_
File

1800 600 1800

Alarme_vitesse Bit SO0:2/0 Déclenche les 
messages 
d’alarmes

ControlNet_Scheduled_
File

0 0 0
Publication 2711-QS003C-FR-P



58        Saisie des points de l’application 
Points de l’application DeviceNet

Le tableau ci-dessous répertorie les points d�application utilisés par l�application DeviceNet. Les champs qui n'y 
figurent pas acceptent les valeurs par défaut.

Points de l'application EtherNet/IP

Le tableau ci-dessous répertorie les points d'application utilisés par l'automate ControlLogix dans l'application 
EtherNet/IP avec l'adressage de l'automate. Les champs qui n'y figurent pas acceptent les valeurs par défaut.
 

Nom du point Type de 
données Adresse Description Nom de 

station
Valeur
initiale Min Max

Démarrage_du_moteur Bit I:00/0 Fait démarrer le moteur LC_1 0 0 0

Arrêt_du_moteur Bit I:00/1 Arrête le moteur LC_1 0 0 0

Ind_état_moteur Bit O:0/0 Moteur en marche/moteur 
arrêté

LC_1 0 0 0

Vitesse_du_moteur Entier non 
signé

O:1 Indique la vitesse du moteur LC_1 0 0 65535

Vitesse_maxi_moteur Entier non 
signé

I:1 Définit la vitesse maximale LC_1 1800 600 1800

Alarme_vitesse Bit O:2/0 Déclenche les messages 
d’alarmes

LC_1 0 0 0

Nom du point Type de 
données Adresse Description Nom de 

station
Valeur
initiale Min Max

Démarrage_du_moteur Bit Motor_Control.00 Fait démarrer le 
moteur

LC_1 0 0 0

Arrêt_du_moteur Bit Motor_Control.01 Arrête le moteur LC_1 0 0 0

Ind_état_moteur Bit Motor_Control.02 Moteur en 
marche/moteur 
arrêté

LC_1 0 0 0

Vitesse_du_moteur Entier 
signé/INT

Motor_Speed[0] Indique la vitesse 
du moteur

LC_1 0 0 65535

Vitesse_maxi_moteur Entier 
signé/INT

Motor_Speed[1] Définit la vitesse 
maximale

LC_1 1800 600 1800

Alarme_vitesse Bit Alarms.00 Déclenche les 
messages 
d’alarmes

LC_1 0 0 0
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Points d'application Modbus

Le tableau ci-dessous répertorie les points d�application utilisés par l�application Modbus. Les champs qui n'y 
figurent pas acceptent les valeurs par défaut.

Saisie des points de l’application
Pour tous les protocoles de communication, entrez les points dans la fiche de configuration. Chaque fiche de 
configuration comporte un onglet indiquant le nom du protocole pour lequel les points sont créés. Pour 
DeviceNet, cliquez sur l�onglet DNet-E/S esclaves avant d�entrer les points. Pour Ethernet, cliquez sur 
l'onglet ENet - Adresse de l'automate.
Suivez la procédure ci-dessous pour entrer chaque ligne (les figures qui suivent illustrent les points pour le 
protocole DH+, mais la procédure est similaire pour les autres protocoles).

1. Sélectionnez Affichage>Attributs étendus ou cliquez sur l�outil Attributs étendus pour afficher 
les champs Valeur initiale, Echelle, Offset, Minimum et Maximum. 

2. Sélectionnez Edition>Insérer un point ou cliquez sur l�outil Insérer un point de la barre d�outils.
3. Cliquez deux fois dans le champ Tag Name (Nom du point) et tapez Start_Motor 

(Démarrage_du_moteur).

Nom du point
Type de 
données 
Type

Adresse de point Description
Nom 
de station

Valeur
initiale Type

Démarrage_moteur Bit 1 Fait démarrer le 
moteur

LC_1 0 Bobine de 
sortie

Arrêt_moteur Bit 2 Arrête le moteur LC_1 0 Bobine de 
sortie

Ind_état_moteur Bit 3 Affiche l’état 
marche/arrêt du 
moteur

LC_1 0 Bobine de 
sortie

Vitesse_moteur Entier non 
signé/INT

1 Indique la vitesse 
du moteur

LC_1 0 Registre de 
stockage

Vitesse_maxi_moteur Entier non 
signé/INT

2 Définit la vitesse 
maximale

LC_1 1800 Registre de 
stockage

Alarme_vitesse Bit 17 Déclenche les 
messages 
d’alarmes

LC_1 0 Bobine de 
sortie
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4. Cliquez sur la flèche dans le champ Data Type (Type de données) et sélectionnez Bit.

5. Cliquez deux fois dans le champ Address (Adresse) et tapez B3:0/0. Pour le réseau Modbus, tapez 1 
dans le champ Address (Adresse).

6. Cliquez deux fois dans le champ Description et saisissez Starts the Motor (Fait démarrer le 
moteur).

7. Cliquez sur la flèche dans le champ Node Name (Nom de station) et sélectionnez LC_1. Ce nom de 
station a été entré pour l�automate lors de la définition des paramètres de communication.

Les paramètres par défaut sont acceptés pour les autres attributs de points. Toutefois, pour le point 
Set_Max_Motor_Speed (Vitesse_maxi_moteur), entrez 600 dans le champ Minimum et 
1800 dans les champs Initial Value (Valeur initiale) et Maximum. La valeur minimum 
de 600 n'est pas applicable en réseau Modbus. 

Pour une application en réseau Modbus, tapez Registre de stockage ou Bobine de sortie dans le 
champ Type tel qu'illustré à la page précédente.
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8. Répétez les étapes 2 à 7 pour entrer le reste des points.
Lorsque tous les points sont entrés, l�éditeur de points doit ressembler à celui-ci  :

Pour une application en réseau Modbus, l'éditeur de points se présente normalement comme suit.

9. Enregistrez les points en sélectionnant Fichier>Enregistrer le projet.

10. Fermez l�éditeur de points en cliquant sur le X dans la barre de titre.

11. Fermez les vues en cliquant sur le X dans la barre de titre ou en sélectionnant Vue>Fermer.

Enregistrement de l’application
Sélectionnez Fichier>Enregistrer ou cliquez sur l'icône Enregistrer de la barre d�outils.
Publication 2711-QS003C-FR-P



62        Saisie des points de l’application 
Publication 2711-QS003C-FR-P 



Chapitre 6

Chargement de l’application

Ce chapitre explique comment :
• valider l'application ;
• charger l�application via une connexion série point à point ;
• fermer l�application.

Vérification de l’application
Cette section explique comment vérifier si l�application contient des erreurs. L�application est aussi validée 
automatiquement pendant le chargement.

1. Sélectionnez Application>Validate All (Valider tout). L�application est vérifiée.
Si l'application est validée, la boîte de dialogue ci-dessous s�affiche.

2. Cliquez sur OK.
En cas d�erreurs ou de mises en garde, la fenêtre Exceptions (Résultats) s'ouvre. Vous devez corriger les erreurs 
avant de pouvoir charger l�application. La correction des mises en garde est facultative.

Une fois les erreurs supprimées, vous pouvez ouvrir de nouveau la fenêtre de résultats en cliquant deux fois 
dessus dans le dossier Système de la fenêtre d�application. 
Pour obtenir une aide supplémentaire sur la validation d�une application, sélectionnez Aide>Rubriques 
d’aide. Sélectionnez l�onglet Index et entrez les mots valider l’application.

Cliquez ici pour fermer la fenêtre.

Cliquez deux fois sur une erreur ou une mise en garde 
pour atteindre la source de l’erreur. 

Pour obtenir de l’aide, sélectionnez une erreur et cliquez 
sur F1 ou sélectionnez Résultats>Détails.
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Chargement de l’application
Terminaux PanelView DH+, RI/O, DF1, ControlNet, DeviceNet, EtherNet/IP, Modbus 

Cette section explique comment transférer une application de votre ordinateur à un terminal PanelView DH+, 
RIO, ControlNet, DeviceNet, EtherNet/IP ou Modbus avec une connexion série point à point et le driver DF1 
de PanelBuilder32.
Vérifiez les connexions de câble comme indiqué au chapitre 1.

1. Sélectionnez File>Download (Fichier>Charger).
La boîte de dialogue Download File (Chargement du fichier) s'ouvre. Elle contient le nom de l�application 
et celui du driver utilisé pour charger l�application. 

2. Cliquez sur OK.
L�application est validée (vérifiée) puis chargée sur le terminal. La boîte de dialogue suivante s�ouvre pour 
indiquer l�état du chargement. 

Une fois le chargement terminé, le terminal se réinitialise, vérifie l'application et affiche la vue de démarrage.

Les paramètres doivent être définis ainsi pour 
correspondre aux paramètres fixes du terminal.

Vous pouvez suivre la 
progression des tâches 
de chargement.

Les erreurs apparaissent ici.
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Terminaux PanelView DH485 et RS232 (protocole DH485)

Cette section explique comment charger une application de l�ordinateur sur un terminal PanelView DH485 ou 
RS-232 (protocole DH485) à l�aide du driver RSLinx 1747-PIC. RSLinx est installé en même temps que 
PanelBuilder32.

Vérifiez les connexions de câble comme indiqué au chapitre 1.

1. Configurez le driver RSLinx 1747-PIC comme décrit dans les étapes 2 à 5.

2. Sélectionnez Fichier>Config. station puis Configurer les drivers RSLinx dans la boîte de 
dialogue Config. station.
La boîte de dialogue Configure Drivers (Configuration des drivers) s�ouvre.

3. Sélectionnez 1747-PIC / AIC+ dans le menu déroulant et cliquez sur Add New (Ajouter un 
nouveau).
Vous êtes invité à entrer un nom de driver.

IMPORTANT Le driver DF1 ne sera pas disponible si l�un des ports série de l�ordinateur est 
configuré pour utiliser le driver RSLinx.
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4. Cliquez sur OK pour enregistrer le nom du driver.
La boîte de dialogue ci-dessous apparaît : elle vous permet de configurer le driver PIC.

5. Cliquez sur OK, puis redémarrez l�ordinateur pour charger le nouveau driver.

6. Sélectionnez File>Download (Fichier>Charger).

La boîte de dialogue Download File (Chargement du fichier) s'ouvre. Elle contient le nom de 
l�application. Sélectionnez le driver 1747-PIC afin de l�utiliser pour charger l�application. 

Réseau RSLinx

Driver 1747-PIC
Publication 2711-QS003C-FR-P 



Chargement de l’application        65
7. Cliquez sur OK.
L�application est validée (vérifiée) puis chargée sur le terminal. La boîte de dialogue suivante s�ouvre pour 
indiquer l�état du chargement. 

Une fois le chargement terminé, le terminal se réinitialise, vérifie l'application et affiche la vue de démarrage.

Fermeture de l’application et de PanelBuilder32

1. Sélectionnez Fichier>Fermer ou cliquez deux fois sur le X dans le coin supérieur droit de la fenêtre 
d�application.

2. Sélectionnez Fichier>Quitter pour quitter PanelBuilder32.

Vous pouvez suivre la 
progression des tâches 
de chargement.

Les erreurs apparaissent ici.
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Chapitre 7

Exécution de l’application

Ce chapitre vous indique comment vérifier le bon fonctionnement de l�application.

Vue Etat du moteur
Une fois l�application chargée sur le terminal PanelView, celui-ci affiche la vue Etat du moteur.

Pour démarrer/arrêter le moteur :

1. Appuyez sur la touche [F1]. Sur les écrans tactiles, toquez sur 

Remarquez que le texte change chaque fois que vous appuyez sur le bouton-poussoir.

2. Arrêtez le moteur en appuyant sur [F2] ou en toquant sur  sur l'écran tactile. Remarquez que le 

texte change également lorsque vous appuyez sur le bouton d'arrêt du moteur.

Vitesse du 
moteur

F3

Arrêt
du moteur

F2

Démarrage
du moteur

F1

ETAT DU MOTEUR

Moteur arrêté Vitesse du moteur
568

Démarrage
du moteur

F1

Démarrage
du moteur

F1

Moteur
en marche

Arrêt
du moteur

F2

Arrêt
du moteur

F2

Moteur
arrêté
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3. Appuyez sur les boutons Démarrage du moteur/Arrêt du moteur : l�indicateur d�état du moteur change 
également.

Vue Réglage de la vitesse du moteur

Appuyez sur [F3] pour accéder à la vue Réglage de la vitesse du moteur. Sur les écrans tactiles, toquez sur 

Pour entrer la vitesse du moteur :

1. Appuyez sur la touche [F1]. Sur les écrans tactiles, toquez sur 

Le pavé numérique apparaît.

 Vitesse 
du moteur

F3

Arrêt
du moteur

F2

Démarrage
du moteur

F1

ETAT DU MOTEUR

Moteur arrêté Vitesse du moteur
568

Moteur en marche

Moteur arrêté

 Vitesse 
du moteur

F3

REGLAGE DE LA VITESSE DU MOTEUR

 Etat du 
moteur

F2

850

Entrer vitesse maximum

Entrer vitesse maximum
####

Pavé d’un terminal à clavier et à clavier/écran tactile
               

Pavé d'un terminal 900/1000/1400 à écran tactile 

Pavé d’un terminal 550 à 
écran tactile uniquement 

La valeur courante est entrée dans le pavé
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2. Entrez une vitesse de moteur comprise entre 600 et 1800, en utilisant les touches d�entrée numérique. Sur 
les écrans tactiles, toquez sur les touches numériques affichées à l�écran.

Remarque : pendant la saisie de données, attendez que le numéro entré apparaisse dans le pavé avant 
d�entrer le suivant.

3. Appuyez sur Entrée (↵ )  pour enregistrer la valeur et fermer le pavé.

4. Appuyez sur la touche [F2]. Sur les écrans tactiles, toquez sur 

Remarquez que la nouvelle vitesse de moteur s'affiche dans la vue Etat.

La nouvelle vitesse ne sera appliquée qu'une fois le moteur arrêté, puis redémarré.

Bandeau d’alarmes
Créez une condition d�alarme en entrant une vitesse de moteur maximale comprise entre 1200 et 1500 (comme 
décrit dans la section précédente), puis en démarrant le moteur. Un bandeau d�alarmes s�affiche par-dessus la 
vue active.

Pour acquitter l�alarme, appuyez sur la touche [F4]. Sur les écrans tactiles, toquez sur  

Le bandeau d�alarmes disparaît.
Remarque : lorsque la vitesse de moteur est comprise entre 1500 et 1800 tpm, le message d�alarme qui 
s�affiche est différent.

 Etat du 
moteur

F2

 Vitesse du 
moteur

F3

Arrêt
du moteur

F2

Démarrage
du moteur

F1

VITESSE DU 
MOTEUR 
ELEVEE

VITESSE DU MOTEUR ÉLEVÉE

Acq
F4

VITESSE 
DU 
MOTEUR 
ELEVEE

Acq
F4
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Annexe A

Programmes d'application

Cette annexe répertorie les programmes logiques à relais nécessaires pour l�exécution de l�application exemple 
sur le terminal PanelView. Elle contient trois sections :

• programmes d�application PanelBuilder32 ;
• programmes logiques à relais ;
• configuration du scrutateur DeviceNet.
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Programmes d’application PanelBuilder32
Les fichiers suivants se trouvent sur le CD d�installation de PanelBuilder32, dans le répertoire QuickStart\PV.

Fichiers d’application PanelBuilder32

Nom de fichier A utiliser avec l’application :

CL_DHP.pba • Automate ControlLogix avec module DH+ (1756-DHRIO)
• Module DHRIO configuré pour l’emplacement 1
• Canal 1 de DHRIO configuré pour 57,6 Kbauds

CL_rio. pba • Automate ControlLogix avec module RIO (1756-DHRIO)
• Module DHRIO dans l’emplacement 1
• Canal 2 de DHRIO configuré pour 57,6 Kbauds

CLCNetS.pba • ControlLogix avec passerelle ControlNet (1756-CNB)
• Passerelle ControlNet configurée pour l’emplacement 1
• Messagerie prioritaire

CLCNetU.pba • ControlLogix avec passerelle ControlNet (1756-CNB)
• Passerelle ControlNet configurée pour l’emplacement 1
• Messagerie non prioritaire

CL_Enet.pba • Automate ControlLogix avec module 1756-ENET/B
• Adressage réseau
• Emplacement 1

PLC_Enet.pba • PLC-5E (Ethernet) 

SLC_Enet.pba • SLC 5/05 (Ethernet)

DF1.pba • Tout SLC-5/03, 5/04, 5/05, PLC-5 évolué ou MicroLogix

DNet.pba • 1756-DNB configuré pour l’emplacement 1 avec un automate ControlLogix
• 1771-SDN configuré pour l’emplacement 1 avec un automate PLC-5
• 1747-SDN configuré pour l’emplacement 1 avec un automate SLC 

MLDH485.pba • MicroLogix avec RS-485

PLC_DHP.pba • PLC-5 avec module DH+

PLC_RIO.pba • PLC-5 avec module RIO

PLCCNetU.pba • PLC-5 avec ControlNet
• Messagerie non prioritaire

SLC_DHP.pba • SLC-5/04 avec module DH+

SLC_RIO.pba • SLC avec module RIO
• Module RIO configuré pour l’emplacement 1

SLCDH485.pba • 1761-NET-AIC peut être requis
• Tout SLC 

Remarque : le canal 0 du SLC 5/04 ou 5/05 peut être configuré pour le protocole DH485.
• Configurez l’application PanelBuilder afin qu’elle corresponde à la référence du 

PanelView.

Modbus.pba • MicroLogix 1200/1500 
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Programmes logiques à relais
Les fichiers suivants se trouvent sur le CD d�installation de PanelBuilder32.

Programmes de l’automate ControlLogix (répertoire QuickStart\CL) 

Programmes de l’automate PLC-5 (répertoire QuickStart\PLC)

Nom de fichier A utiliser avec l’application : Page :

cnet_sch.acd • ControlLogix à l’emplacement 0
• Module 1756-CNB de ControlLogix à l’emplacement 1
• Messages prioritaires

75

cnet_unsch.acd • ControlLogix à l’emplacement 0
• Module 1756-CNB de ControlLogix à l’emplacement 1
• Messages non prioritaires

77

dhp.acd • ControlLogix à l’emplacement 0
• 1756-DHRIO à l’emplacement 1
• Canal 1 de DHRIO configuré pour 57,6 Kbauds

79

dnet.acd • ControlLogix à l’emplacement 0
• Module 1756-DNB de ControlLogix à l’emplacement 1
• Vitesse définie à 125 Kbauds

81

rio.acd • ControlLogix à l’emplacement 0
• Adresse IP : 10.0.0.1
• 1756-DHRIO à l’emplacement 1
• Canal 2 de DHRIO configuré pour 57,6 Kbauds

83

enet.acd • ControlLogix à l’emplacement 0
• Module 1756-ENET/B module à l'emplacement 1
• Adressage réseau comme type de message

85

Nom de fichier A utiliser avec l’application : Page :

cnet.rsp • PLC-5C 105

dhp_df1.rsp • Tout PLC-5 évolué pour DF1
• Tout PLC-5 pour DH+

107

dnet.rsp • Tout PLC-5
• Scrutateur DeviceNet 1771-SDN à l’emplacement 1

109

rio.rsp • Tout PLC-5
• Port RIO

112

enet.rsp • PLC-5E (Ethernet)
• Adresse IP : 10.0.0.1

114
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Programmes de l’automate SLC (répertoire QuickStart\SLC)

Programmes de l’automate MicroLogix (répertoire QuickStart\ML)

Nom de fichier A utiliser avec l’application : Page :

dh485.rss • Le canal 0 doit être utilisé sur un SLC 5/04 ou 5/05 avec 
un coupleur de liaison 1761-NET-AIC

91

df1.rss • SLC 5/03, 5/04, 5/05
• Canal 0 configuré pour DF1, sans parité, CRC et pas 

d’échange
• Vitesse définie à 9600 Kbauds

Important : il sera peut-être nécessaire de convertir la logique 
à relais en fonction de l’automate.

87

dhp.rss • SLC 5/04
• Canal 1 configuré pour DH+ à 57,6 Kbauds

95

dnet.rss • SLC 5/02, 5/03, 5/04, 5/05
• Scrutateur DeviceNet 1747-SDN à l’emplacement 1
• Vitesse définie à 125 Kbauds

Important : il sera peut-être nécessaire de convertir la logique 
à relais en fonction de l’automate.

97

rio.rss • SLC 5/02, 5/03, 5/04, 5/05
• Scrutateur 1747-SDN à l’emplacement 1
• Vitesse définie à 57,6 Kbauds

Important : il sera peut-être nécessaire de convertir la logique 
à relais en fonction de l’automate.

99

enet.rss • SLC 5/05E (Ethernet)
• Adresse IP : 10.0.0.1

101

Nom de fichier A utiliser avec l’application : Page :

df1.rss • MicroLogix 1000 série C ou ultérieure
Important : il sera peut-être nécessaire de convertir la logique 
à relais en fonction de l’automate.

89

dh485.rss • MicroLogix 1000 série C ou ultérieure
• Il sera peut-être nécessaire d’utiliser un coupleur de 

liaison 1761-NET-AIC
• Le canal 0 doit être utilisé sur un SLC 5/04 ou 5/05 

avec un coupleur de liaison 1761-NET-AIC

Important : il sera peut-être nécessaire de convertir la logique 
à relais en fonction de l’automate.

93

modbus.rss • MicroLogix 1200/1500 Série C et suivantes

Important : il sera peut-être nécessaire de convertir la 
logique à relais pour l�automate approprié.

103
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cnet_sch.acd
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cnet_unsch.acd
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dhp.acd
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dnet.acd
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rio.acd
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enet.acd
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df1.rss
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df1.rss (pour la famille MicroLogix)
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dh485.rss
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dh485.rss (pour la famille MicroLogix)
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dhp.rss
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dnet.rss
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rio.rss
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enet.rss
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modbus.rss (pour la famille MicroLogix)
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cnet.rsp
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dhp_df1.rsp
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dnet.rsp
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rio.rsp
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enet.rsp
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Programmes du scrutateur
Les fichiers suivants se trouvent sur le CD d�installation de PanelBuilder32 dans le répertoire 
\QuickStart\DNet.

Applications DeviceNet utilisant RSNetworx pour DeviceNet

Nom de fichier A utiliser avec les fichiers d’application :

1747sdn.dnt • dnet.rss
• dnet.pba

1756dnb.dnt • dnet.acd
• dnet.pba

1771sdn.dnt • dnet.rsp
• dnet.pba
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